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Introduction

This cookbook provides information, tips, and techniques for CMS architects and
developers to optimize Sitecore client user interface usability.

This document contains the following chapters:
e Chapter 1 — Introduction
e Chapter 2 — Common Procedures
e Chapter 3 — Data Templates and Items
e Chapter 4 — Data Validation
e Chapter 5 — The Page Editor

e Chapter 6 — Security Based Configuration Features

! For client hardware requirements, see the Installation guide at
http://sdn.sitecore.net/Products/Sitecore%20V5/Sitecore%20CMS%206/Installation.aspx. For instructions
to configure Internet Explorer, see the Internet Explorer Configuration Reference manual at
http://sdn.sitecore.net/Reference/Sitecore%206/IE%20Configuration%20Reference.aspx.
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Common Procedures

This chapter provides instructions for common procedures required by other procedures
described in this and other documents.

This chapter contains the following section:

e Common Procedures
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2.1 Common Procedures

This section provides instructions for common procedures required by other procedures described in this
and other documents.

2.1.1 How to Select a Database in the Sitecore Desktop
To select a database in the Sitecore Desktop:

1. Inthe browser, access the Sitecore login page, such as http://localhost/sitecore.

2. Inthe browser, in the Sitecore login page, click the Advanced tab, then click the Desktop option,
and then Log in as an administrator. The Sitecore desktop appears in the browser.

3. Inthe browser, in the Sitecore desktop, in the lower right corner, click the database icon, and then
click the database name. The Sitecore desktop refreshes, closing any open applications. If you
open the Content Editor or other applications within the Sitecore desktop, they will access the
database you selected until you log out or select a different database.

Important
To reduce the potential for making changes to a database unintentionally, always select the master
database after working with one of the other databases.

Important
Unless otherwise specified, all procedures in this and other Sitecore documentation assume that you
have selected the master database.

2.1.2 How to Show or Hide the Standard Fields
To show or hide the standard fields:
1. Inthe Template Manager or the Content Editor, click the View tab.

2. Inthe Template Manager or the Content Editor, in the View group, and then select or clear the
Standard Fields checkbox.

Note
Showing the standard fields can affect user interface performance.

2.1.3 How to Show or Hide Raw Values

You may investigate the text value of a field by viewing its raw value. For example, you may view raw
values to determine the attributes of a field such as image that stores a single XML element.

To show or hide raw values, in the Template Manager or the Content Editor, click the View tab, and then
in the View group, select or clear the Raw Values checkbox.

2.1.4 How to Show or Hide the Developer Tab

The Developer tab provides convenience features for developers working with Sitecore solutions. To
show or hide the Developer tab, in the Content Editor, right-click the tabstrip, and then click the Developer
option.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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2.1.5 How to Copy the ID or Path of an Item to the Windows Clipboard
To copy the path to an item to the Windows clipboard:
1. Inthe Template Manager or the Content Editor, select the item, and then click the Content tab.

2. Inthe Quick Info section, click and drag the mouse across the value of the ID or Item Path
property. To copy the path to the Windows clipboard, press CTRL-C, or right-click the selected
text and then select copy.

Tip

You can also copy the ID or path to an item by using the ID and Path commands in the Show group on
the Developer tab. For more information about the Developer tab, see the section How to Show or Hide
the Developer Tab.

2.1.6 How to Enter a Class Signature
A class signature identifies a class in a .NET assembly.
To enter a class signature:

1. Enter the following prototype:

Namespace.Class, Assembly
2. Replace Namespace with the namespace containing the class.
3. Replace class with the name of the class.

4. Replace Assembly with the name of the assembly containing the class, without the .d11
extension.
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Data Templates and Items

This chapter provides tips and describes techniques for configuring data templates and
items, including controlling item, section, and field appearance, custom item editors, and
insert options.
This chapter contains the following sections:

e |tem Appearance

e Data Template Sections

e Data Template Fields

e Custom User Interfaces in Data Templates

e Insert Options
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3.1 Iltem Appearance

You can use the following features to control the appearance of items in the content tree. A field in the
standard template defines the icon for each item.

3.11 Ilcons

Sitecore user interfaces, including the content tree in the Content Editor, display an icon next to each
item.

Developers use icons:

e To differentiate specific items visually.

e To differentiate items based on specific templates visually.
If an item does not specify an icon, the content tree displays the icon specified in data template
associated with the item. If that data template does not specify an icon, then the content tree displays the

icon specified by the value attribute of the /configuration/sitecore/settings/setting
element in web.config with name DefaultIcon.

Note

Sitecore supports theming. Sitecore interprets relative icon paths as relative to the
/sitecore/shell/themes/standard directory. For example, the value
applications/16x16/star yellow.png iS equivalent to
/sitecore/shell/themes/standard/applications/16x16/star yellow.png.

Note
An icon can be an arbitrary URL of an image.

How to Set the Icon for an Item
To set the icon for an item:
1. Inthe Content Editor, edit the item.
2. Click the Configure tab.
3. Inthe Appearance group, click the Icon command. An icon selection menu appears.
4

In the icon selection menu, select an icon, or click More Icons and use the icon selection dialog.

Note
The icon selection dialog may load slowly when presenting a large number of images in a single directory.

Tip
As a shortcut to access the icon selection dialog, in the editing pane, click the Content tab, and then click
the icon in the item title bar.

Important
Rather than setting the icon for individual items, set the icon for each data template to apply that icon to
the data template, its standard values item, and all other items based on that template.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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How to Set the Default Icon for All tems Based on a Data Template
To set the default icon for all items based on a data template:
1. Inthe Template Manager, edit the data template definition item.

2. Setthe icon in the data template definition item as described in the section How to Set the Icon
for an Item.

Important

Set the icon in the definition item for each data template, not in the standard values item for the data
template. If you only set the icon in the standard values item for the data template, the icon does not
apply to the data template itself; the icon shown for the data template in the content tree remains the
default icon.

How to Change the Default Icon for All Items

To set the default icon for all items for which the item, its data template, and the standard values item
associated with its data template do not define an icon, in the web . config file, in the
/configuration/sitecore/settings/setting with the name DefaultIcon, setthe value
attribute to the default icon path.

How to Configure the Icon Selection Menu

To configure the icons that appear in the icon selection menu, edit the file
/App_Config/Icons.config. Each collection element defines a row, and contains a pipe-separated
list of absolute or relative paths to icon files.

3.1.2 Hidden Items

Hidden items do not appear in the content tree for users who do not have permission to show hidden
items, or have not chosen to show hidden items.

How to Show or Hide Hidden Items

To show hidden items, the user must be an administrator, or a member of either the Sitecore Client
Developing role or the Sitecore Client Maintaining role.

To show hidden items:
1. Inthe Content Editor, click the View tab.

2. Inthe View group, select or clear the Hidden Items checkbox.

How to Show or Hide an Item

To hide or show an item, the user must be an administrator, or a member of the Sitecore Client
Configuring role.

To show or hide an item:
1. Inthe Content Editor, edit the item.
2. Click the Configure tab.

3. Inthe Attributes group, click the Hide Item command to hide the item, or click the Make the Item
Visible command to show the item.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 11 of 59



Sitecore CMS 6.1 Client Configuration Cookbook @ S|teco re

3.1.3 Protected Items

No user can edit protected items through Sitecore user interfaces.

How to Protect or Unprotect an Item

To protect or unprotect an item, the user must be an administrator or a member of the Sitecore Client
Configuring role.

To protect or unprotect an item:
1. Inthe Content Editor, edit the item.
2. Click the Configure tab.

3. Inthe Attributes group, click the Protect Item command to protect the item, or click the Unprotect
Item command to unprotect the item.

3.1.4 Item Styles

Item styles control the appearance of the names displayed for each item in the content tree. Developers
use item styles to highlight and differentiate visually specific items or items based on specific templates.
For example, certain system items appear in green text by default, and proxy items to appear grayed out.

To style individual items, developers apply item styles to items. More commonly, developers apply items
styles to data templates to style all items based on those templates.

How to Configure the Style of an Item Name in the Content Tree

You can use the tree node style to configure the styling of item names in the content tree. To configure
the tree node style for item names:

1. Inthe Template Manager or the Content Editor, edit the standard values item or the individual
item, and then click the Configure tab.

2. Inthe Template Manager or the Content Editor, with the standard values item or the individual
item selected, in the Appearance section, click the Tree Node Style command. The Tree Node
Style dialog appears.

3. Inthe Tree Node Style dialog, style dialog, enter CSS styles, or click the Edit button to use the
CSS style wizard. For example, enter COLOR: red; to set the color of the font to red.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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Note
Sitecore uses COLOR: green for system items and COLOR: gray for proxy shadow items. Avoid using
these tree node styles for other purposes.

3.1.5 Display Name

If defined, the display name of an item appears in user interfaces such as the content tree instead of the
name of the item.?

Developers use display names:

e To provide helpful item names in the content tree without affecting the default URL for content
items.

e To allow characters not allowed in item names to appear in the content tree.

% For information about using display names in URLS, see the Dynamic Links guide at
http://sdn.sitecore.net/Reference/Sitecore%206/Dynamic%20Links.aspx
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Warning
Use display names in limited cases, such as where you must display characters not allowed in item
names.

How to Set the Display Name for an Iltem
To set the display nhame for an item:
1. Inthe Content Editor, edit the item.
2. Click the Home tab.
3. Inthe Rename group, click the Display Name command. The display name prompt appears.
4

In the display name prompt, enter the display name for the item.

3.1.6  Context-Sensitive Help
Editorial interfaces can display helpful information about the selected item and its data template.
Developers use context sensitive help:
e To provide useful information to users working with items based on a specific data template.
e To provide useful information to users working with a specific item.
The item title bar displays the short description defined in the help properties of the item or its data

template. When you move the mouse over an item in the content tree, Sitecore displays the long
description of the item or its template as a tooltip.

If the developer has not defined any help properties for the item, Sitecore uses the help properties
defined in the item’s data template.

How to Set Item Context-Sensitive Help
To set context-sensitive help for a data template or an individual item:
1. Inthe Template Manager or Content Editor, edit the standard values item or the individual item.
2. Click the Configure tab.
3. Inthe Appearance group, click the Help command. The help properties dialog appears.
4. For Short Description, enter a short description of the type of item or the individual item.
5

For Long Description, enter a long description of the type of item or the individual item.
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3.2 Data Template Sections

Each data template contains one or more sections, and each section contains one or more fields. Data

template sections allow developers to organize fields into related groups. Organizing fields into sections
avoids the appearance of monolithic data entry forms, and allows users to collapse sections of the form
that they are not currently using. Developers also use data template sections to contain groups of fields
that you can reuse in multiple data templates.

Data templates with large number of sections, and sections with large numbers of fields, can reduce
usability and performance. To improve performance, it is especially important to avoid creating data
templates with large numbers of Rich Text Editor (RTE) fields. Instead, developers use other field types,
or represent the data using a hierarchy of items associated with different data templates.

Logical sorting of data template sections and fields helps users locate the fields they wish to update.
Consider sorting sections and fields in the same order that presentation components render field values
in page views. Alternatively, place the sections and fields that are most important or updated most
frequently towards the top of the data template.

Using appropriate data template section and field names helps users locate the fields they wish to
update. For example, if the data template for news articles defines only a few fields such as Author and
Date, consider placing those fields in a section named News, and do not use this section name for any
fields that are not specific to news articles. Overly general section names such as Data do not provide the
same contextual assistance in templates that contain numerous fields.

If a data template and any of its base templates define sections with a common name, the Content Editor
renders all the fields in those sections as a single visual section. The sort order property of sections and
fields controls their order relative to other sections and fields in the template.

3.2.1 Data Template Section Icons

Data template section headers in the Content Editor display the icons associated with each data template
section. Developers specify icons for data template sections to help users locate the fields they want to
edit.

Note

If a data template section definition item does not specify an icon, then Sitecore uses the icon specified
by the value attribute of the /configuration/sitecore/settings/setting elementin

web . config with name DefaultIcon.

3.2.2 How to Set a Data Template Section Icon
To set the icon for a data template section:
1. Inthe Template Manager, edit the data template section definition item.

2. Set the icon as described How to Set the Icon for an ltem

3.2.3 Data Template Section Sort Order

You can sort data template sections using Template Builder, or by setting the sort order property of a data
template section definition item.
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Note

To control the order of sections when a data template and its base templates define different data
template sections, set the sort order property of data template section definition items.

How to Sort Data Template Sections

To sort the data template sections in a data template:

1.

2
3
4.
5

In the Template Manager, select the data template definition item.

In the editing pane, click the Builder tab. The Template Builder appears.

Click the Builder Options tab.

In the Template Builder, click the mouse in the section name to select that section.

In the Sorting group, click the Up, Down, First, and Last commands to sort the section relative to
the other sections in the data template.

How to Set the Sort Order Property of a Data Template Section Definition Item

To set the sort order property of a data template section definition item:

1.

2
3.
4

In the Template Manager, edit the data template section definition item.
Show the standard fields as described in the section How to Show or Hide the Standard Fields.
In the Appearance section, in the Sortorder field, enter a numerical value.

Hide the standard fields.
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3.3 Data Template Fields

You can use the features described in this section to optimize the usability of data template fields.

3.3.1 Data Template Field Headers and Context-Sensitive Help

The Content Editor displays field headers above each field. Developers use field headers to provide
instructions and contextual information to users working with a field value.

Each field header consists of a number of elements, including:
e The field title, which defaults to the field name.
e Thetoken [standard value], if the field contains its standard value.

e Thetoken [shared], if the field contains a value shared to all versions of the item in all
languages.

e Thetoken [unversioned], if the field contains a value that is not versioned, but may differ by
language.

¢ Field editing controls appropriate for the field type.

The long description of the field appears when the user moves the mouse over the field title.

For fields that define a help link, the title and short description in the field header link to the specified URL.

How to Set the Title for a Data Template Field

To set the title for a data template field, causing the field label in the Content Editor to differ from the
name of the field definition item:

1. Inthe Template Manager, edit the data template field definition item.

2. Inthe Data section, in the Title field, enter the title of the field.

How to Set Context-Sensitive Help for a Data Template Field
To set context-sensitive help for a data template field:
1. Inthe Template Manager, edit the data template field definition item.
Click the Configure tab.
In the Appearance group, click the Help command. The help properties dialog appears.
For Short Description, enter a short description of the field.

For Long Description, enter a long description of the field.

o g A~ w DN

For Help Link, enter the URL of a resource containing helpful information about the field.

3.3.2 How to Style a Data Template Field

To style a data template field:
1. Inthe Template Manager, edit the data template field definition item.
2. Click the Configure tab.
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In the Appearance group, click the Tree Node Style command. The CSS style dialog appears.

4. Inthe CSS style dialog, in the text field, enter CSS styles, or click the Edit button to use a CSS
style wizard. For example, enter HEIGHT: 600px; to set the height of a Rich Text Editor, or
FONT-WEIGHT:bold; to style the text in a single-line text field.

3.3.3 Data Template Field Sort Order

Explicitly set the sort order property of data template field definition items to control the order of fields
when a data template and its base templates define the same data template sections.

How to Sort Data Template Fields
To sort data template fields:
1. Inthe Template Manager, edit the data template definition item.
2. Inthe editing pane, click the Builder tab. The Template Builder appears.
3. Inthe Template Builder, click the mouse in the field name to select that field.
4

In the Sorting group, click the Up, Down, First, and Last commands to sort the field relative to the
other fields in the section.

How to Set the Sort Order Property of a Data Template Field Definition Iltem
To set the sort order property of a data template field:

1. Inthe Template Manager, edit the data template field definition item.

2. Show the standard fields as described in the section How to Show or Hide the Standard Fields.
3. Inthe Appearance section, in the Sortorder field, enter a numerical value.
4

Hide the standard fields as described in the section How to Show or Hide the Standard Fields.

3.3.4  Rich Text Editor (RTE) Configuration
Rich Text Editor (RTE) profiles control the features available in the Rich Text Editor (RTE) fields.
Developers use RTE profiles:

e Toremove features from RTE fields.

e To enable default features in RTE fields.

e To expose different features to different users of RTE fields.

e To configure drop-down menus and other options in RTE fields.

e To add custom features to RTE fields.

e To make different features available in different data templates and different RTE fields in a single
template.

Developers may reference an RTE profile using the source property of each RTE field definition item.
Sitecore stores RTE profiles under /Sitecore/System/Settings/Html Editor Profiles inthe
core database. If the developer does not define the source property for an RTE field, Sitecore applies the
/Sitecore/System/Settings/Html Editor Profiles/Rich Text Default RTE profile.
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Only the definition items that exist in each RTE profile appear in fields using that profile. Access rights
assigned to definition items in the RTE profile control access to RTE features for different users.

Tip

For consistency, accessibility, and reusability, separate design from presentation. RTE fields defeat this

purpose by merging content with styling, such as CSS styles, and presentation, such as HTML tables and
images. In addition to minimizing use of the RTE field type, minimize features available in each RTE field
using RTE profiles.

RTE Profile Definition ltem Reference

The following table describes items that can appear within an RTE profile definition item.

Path

Function

/Buttons/HTML View

Controls whether or not the HTML tab appears at the bottom
of the RTE.

/Class Translation

Maps styling information in content pasted into the pasted
into the RTE to corresponding CSS styles.

/Font Names

Populates the font names drop-down menu.

/Font Sizes

Populates the font sizes drop-down menu.

/Links Populates the Custom Links drop-down menu.
/Paragraphs Populates the elements drop-down menu.
/Ribbon Controls the formatting ribbon in the Page Editor.
/Snippets Populates the snippets feature.

/Tidy This path has been discontinued.

/Toolbar 1

Controls options on the primary toolbar.

/Toolbar 2

Controls options on the secondary toolbar.

/Toolbar 3

Controls options on the tertiary toolbar.

/WebEdit Buttons

Controls formatting buttons shown beneath the field when
inline editing in the Page Editor.

/Zoom

Populates the Zoom drop-down menu.

How to Configure RTE Profiles

To configure RTE Profiles:

1.
2.

In the Sitecore Desktop, select the core database.

Open the Content Editor and select /Sitecore/System/Settings/Html Editor

Profiles.

In each custom RTE profile definition branch, remove options that are unnecessary for all users,
and control the visibility of other options using the i tem: read access right.

In the Sitecore Desktop, select the master database.
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Important

Do not edit the default RTE profiles under the /Sitecore/System/Settings/Html Editor
Profiles item in the Core database. Instead, duplicate an existing RTE profile, and configure RTE data
template field definition items to use that profile.

Tip

To configure the default RTE profile without editing it, duplicate the default RTE profile to create a
backup, and then edit the original.

How to Determine the Path to an RTE Profile
To determine the path to an RTE profile:
1. Inthe Content Editor in the core database, select the RTE profile definition item.

2. Copy the path to the RTE profile definition item to the Windows clipboard as described in the
section How to Copy the ID or Path of an Item to the Windows Clipboard.

3. Inthe Sitecore Desktop, select the master database.

How to Set the Profile for an RTE Template Field Definition Item
To set the RTE profile for an RTE template field definition item:

1. Inthe Template Manager, edit the RTE field definition item.

2. Inthe Data section, in the Source field, enter the path to the RTE profile.

3. Inthe Sitecore desktop, select the master database.

How to Add Features to an RTE Profile

To add features to an RTE profile, copy features from the /Sitecore/System/Settings/Html
Editor Profiles/Rich Text Full RTE profile definition.

How to Set the CSS Used by RTE Fields

To setsthe Cascading Style Sheet (CSS) file used to populate the Apply CSS Class drop-down in all RTE
fields:

1. Close the Rich Text Editor.

2. Inweb.configfile,inthe /configuration/sitecore/settings/setting element with
the name WebStylesheet, set the value attribute to the path to a CSS file.

3. Open the Rich Text Editor to see the change.

How to Limit the CSS Styles Visible in RTE Fields

You can use the CSS import directive to prevent styles from appearing in the Apply CSS Class drop-
down menu in the RTE.

This Apply CSS Class drop-down includes styles defined in the CSS file specified by the value attribute
of the /configuration/sitecore/settings/setting elementin web.config with name
WebStylesheet.

% For information about loading different CSS files into the RTE, see
http://sdn.sitecore.net/Scrapbook/Dynamically%20loading%20web%20stylesheets%20in%20RTE.aspx.
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Most Web sites use CSS styles that are not relevant to content in the RTE. You can use the CSS import
directive to prevent these styles from appearing in the Apply CSS Class drop-down in the RTE.

For example, place the styles that users can apply to content in the RTE in the file
contentstyles.css, and set the WebStylesheet setting to the path to that file relative to the
document root. Place the styles that should not appear in the RTE in the file sitestyles.css inthe
same directory, and reference that file in your layouts. In sitestyles.css, import
contentstyles.css with a CSS import directive such as the following:

@import url (contentstyles.css);
Only styles defined in contentstyles.css appear in the RTE, while presentation components can use
styles defined in both sitestyles.css and contentstyles.css.

Warning
The RTE does not support the CSS import directive. Styles defined in CSS files imported by the CSS
file specified by the WwebStylesheet setting in web. config will not appear in the RTE.

Warning

Due to various levels of caching, changes to CSS files may not be visible in the browser immediately. If
changes to CSS files do not appear, perform the following operations in order until the change appears:
reload the Rich Text Editor, clear the browser cache, restart IS, and change the value of the value
attribute of the /configuration/sitecore/settings/setting elementin web.config with
name WebStylesheet.

How to Configure the RTE HTML Element Types Drop-Down Menu
To configure the HTML element types listed in the RTE:

1. Inthe Content Editor in the core database, under the RTE profile definition item, select
/Paragraphs.

2. Insert anitem using the /System/Html Editor Profiles/Html Editor List Item data
template.

In the Data section, in the Header field, enter the value to display in the elements drop-down.
4. Inthe Value field, enter the HTML element to insert when the user chooses this element type.

In the Sitecore Desktop, select the master database.

How to Enable Snippets in an RTE Profile
To enable snippets in an RTE profile:

1. Inthe Content Editor in the core database, select /Sitecore/System/Settings/Html
Editor Profiles/Rich Text Full/Toolbar 1.

2. Copythe Insert Snippet item to the corresponding location in the RTE profile.

3. Inthe Sitecore Desktop, select the master database.

How to Add a Snippet to an RTE Profile
To add a snippet to an RTE profile:

1. Log in to the Sitecore desktop as a user with administrative rights, and then select the Core
database. For instructions to select a database, see the section How to Select a Database in the
Sitecore Desktop.
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2. Inthe Sitecore desktop, click the Sitecore button, and then click Content Editor. The Content
Editor appears within the Sitecore desktop.

3. Inthe Content Editor, select the Snippets item beneath the relevant RTE profile definition item
within the /Sitecore/System/Settings/Html Editor Profiles branch.

4. In the Content Editor, with the Snippets item within the relevant RTE profile definition item
selected, insert a snippet definition item using the /System/Html Editor Profiles/Html
Editor Snippet data template.

5. Inthe Content Editor, in the snippet definition item, in the Data section, in the Header field, enter
the text to display in the snippets drop-down list.

6. Inthe Content Editor, in the snippet definition item, in the Data section, in the Value field, enter
markup to insert when the user chooses the snippet.

7. Inthe Sitecore Desktop, select the Master database.

How to Control the Markup Inserted by the Enter Key

The value attribute of the /configuration/sitecore/settings/setting elementin
web.config with name HtmlEditor.LineBreak controls the markup that the Rich Text Editor inserts
when a user presses the ENTER key. By default, the value of this setting is p, causing the Rich Text
Editor to surround text with paragraph elements (“<p>...</p>"). To insert a line break element (“<br>")
at the end of the line instead of wrapping the text with paragraph elements, change the value of this
setting to br.

Note

If the value of the /configuration/sitecore/settings/setting element with name
HtmlEditor.LineBreak is p, you can insert a line break element (<br>) by pressing CTRL-ENTER. If
the value of this setting is br, you can insert paragraph elements (<p>. . .</p>) by pressing CTRL-M.

How to Disable the RTE HTML Tab for Some or All Users

To remove the HTML tab from the RTE:
1. Inthe Content Editor in the core database, select the RTE editor profile definition item.
2. Delete or restrict read access rights to the /Buttons/HTML View item.

3. Inthe Sitecore Desktop, select the master database.
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3.4 Custom User Interfaces in Data Templates

If Sitecore does not provide the data template user interface elements that you need, you can implement
custom user interface in data templates.

3.41 ThelFrame Field Type

The IFrame data template field type enables developers to cause arbitrary Web applications to appear as
data template fields when working with items in the Content Editor.

Developers use the IFrame field type:
e To add simple custom field editors to data templates.

e To add reports and other custom applications to data templates.

Fields of type IFrame load the URL specified in the source property of the field definition item into an
IFrame in the Content Editor. Sitecore adds the following query string parameters to the URL:

Parameter Function

id The GUID of the item selected by the user.
la The language code selected by the user.
Vs The version number selected by the user.

Developers can pass additional variables by adding query string parameters to the URL specified in the
source property of the IFrame field definition item.

How to Create an IFrame Data Template Field
To create an IFrame data template field:

1. Create a web page containing the IFrame user interface. For information about the query string
parameters passed to the IFrame field, see the section The IFrame Field Type.

In the Template Manger, select the data template definition item.
In the editing pane, click the Builder tab. The Template Builder appears.
In the Template Builder, add a field of type IFrame, and then save the data template.

Edit the IFrame data template field definition item.
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In the Data section, in the Source field, enter the URL of the web page created previously
containing the IFrame user interface.

3.4.2 ltem Editors

Item editors define alternate user interfaces for working with items in the Content Editor. Developers
implement custom item editors:

e To provide arbitrary applications for working with specific items or items based on specific data
templates.
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e To provide summaries, reports, or other interfaces for individual items or items based on specific
data templates.

e To provide a single user interfaces to update a hierarchy of items.

Item editors appear as tabs in the Content Editor when a user selects an item. Each tab in the Content
Editor activates a different item editor. Developers can associate any number of item editors with an item
or a data template. The standard values item for each data template defines default item editors for all
items associated with that template.

The default editor for all items appears as the Content tab in the Content Editor. This interface displays
field editing controls grouped in sections as defined by the item’s data template and its base templates.

Sitecore associates various item editors with specific types of items by default. The Folder item editor for
folders defines the Folder tab listing existing child items and options to create new child items. The
Builder item editor for data templates defines the Builder tab for working with the data template sections
and fields comprising the template.

Item editors are URL-addressable Web applications. Sitecore manages item editors under
/Sitecore/Content/Applications/Content Editor/Editors inthe core database.

Sitecore passes the following query string parameters to item editors:

Parameter Function

id The GUID of the item selected by the user

language The language code selected by the user.

version The version number selected by the user.

database The name of the database containing the item selected by the user.

You can pass additional variables by adding query string parameters in the URL specified in the Url field
in the Data section of the editor definition item.

Note
Item editors supersede the Editor property in previous versions of Sitecore.

How to Configure Item Editors
To configure item editors:

1. Inthe Template Manager or the Content Editor, edit the standard values item or the individual
item.

2. Click the Configure tab.
In the Appearance group, click the Editors command. The custom editors dialog appears.

4. In the custom editors dialog, in the All tree, expand branches and double-click item editors to add
them to the Selected list.

5. To change the order of item editor tabs, in the Selected list, select an item editor and click the
arrows at the right to sort the selection.

6. To remove an item editor, in the Selected list, double-click the item editor.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 24 of 59



Sitecore CMS 6.1 Client Configuration Cookbook @ S|teco re

How to Create an Item Editor

To create an item editor:
1. Create a web page containing the item editor user interface.”
2. Inthe Sitecore Desktop, select the core database.

3. Inthe Content Editor in the core database, select
/Sitecore/Content/Applications/Content Editor/Editors/Items.

4. Insert an item editor definition item using the /Sitecore Client/Content Editor/Editor
data template.

5. Inthe Data section, in the header field, enter a value that Content Editor should display in the tab
that activates the item editor.

6. Inthe Icon field, enter the icon to display in the tab that activates the item editor.

7. Inthe URL field, enter the URL of the web page created previously containing the item editor user
interface.

8. Save the item editor definition item.

In the Sitecore Desktop, select the master database.

* For information about the query string parameters passed to the custom editor, see
http://sdn.sitecore.net/Reference/Sitecore%206/Client%20Configuration%20Reference.aspx.
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3.5 Insert Options
Insert options control the types of items users can insert beneath existing items.”
Developers apply insert options:

e To help users create appropriate types of items under existing items.

e To restrict the types of items users can create under existing items.

e To allow different users to create different types of items under existing items.

e To help users create a number of items with a single action in the user interface.

e To create items programmatically, for example, by invoking a wizard.

® For more information about insert options, see the Data Definition Reference manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Data%20Definition%20Reference.aspx and the Data
Definition Cookbook at
http://sdn.sitecore.net/Reference/Sitecore%206/Data%20Definition%20Cookbook.aspx.
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Data Validation

This chapter provides procedures to configure data validation. Developers use data validation to enforce
rules for data entry. This chapter contains the following sections:

e Validation Overview

e Types of Validation

e Validation Error Levels

e Configuring Validation Rules
e Registering Validators

e Custom Validators

e Validation Actions
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4.1 Validation Overview
You can configure data validation to control how Sitecore handles invalid data.

You can configure Sitecore to invoke validation rules in the Quick Action Bar, in the Validator Bar, when
the user chooses the Validate command in the Proofing group on the Review tab, and when the user
chooses a specific workflow command.

Note
In general, select the same validation rules for all four types of validation.

You can configure different validators to for each data template field, for all data template fields of a data
template field type, for individual items, for all items based on a data template, and for all items.

Important

For each item, Sitecore invokes the item validation rules defined in the item or the standard values item
associated with its data template, as well as global validation rules. For each data template field, Sitecore
invokes the validation rules defined in the data template field definition item, as well as the validation rules
defined in the data template field type validation rules definition item. The number of validators that the
system must invoke for an item affects the server resources used and can affect client performance.

Important
Do not edit the default validator definition items under /sitecore/system/Settings/Validation
Rules. Instead, register additional validators by creating additional validator definition items.

Note

After you stop editing a field value, Sitecore automatically invokes validation rules asynchronously, and
then updates the user interface after validation completes. The value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
Validators.UpdateDelay controls the length of time between the cessation of editing activity and the
invocation of the validators. To disable this automatic revalidation feature, set the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
Validators.AutomaticUpdate to False.

Note
The default Sitecore configuration disables validation in the Quick Action Bar. To enable Quick Action Bar
validation, right-click the Quick Action Bar, and then select Validation Rules.

Tip
Avoid use of the Validation and Validation Text fields in the Data section of field definition items available
in earlier versions of Sitecore in favor of the data validation features described in this document.
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4.2 Types of Validation

You can validate various types of data.

4.2.1 Data Template Field Validation

You can configure Sitecore to validate the contents of each field in each data template.

4.2.2 Field Type Validation

You can configure Sitecore to validate the contents of each of the different field types.

423 ltem Validation

You can configure validation for individual items.

424 Standard Validation

You can configure validation for all items based on a data template by configuring validation rules in the
standard values of that data template.

425 Global Item Validation

You can configure validation that applies to all items.
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4.3 Validation Error Levels

Validation error levels control the actions Sitecore takes on validation results. Each validator returns one
of the following error levels defined in Sitecore.Data.Validators.ValidatorResult.

@ Sitecore

Error Level Ul Color | Function

Unknown Gray Validation incomplete or result otherwise unknown.

Valid Green Valid.

Suggestion Green Suggestions appear in the user interface.

Warning Orange | Warnings appear in the user interface.

Error Red Errors prevent the user from completing workflow
commands associated with the workflow validation
action.

CriticalError | Red Critical errors cause a modal warning when the user
attempts to save an item and prevent the user from
completing workflow commands associated with the
workflow validation action.

FatalError Red Fatal errors cause a modal warning and prevent the

user from saving the item.
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4.4 Configuring Validation Rules

You can configure Sitecore to invoke validation rules in the Quick Action Bar, in the Validator Bar, when
the user chooses the Validate command in the Proofing group on the Review tab, and when the user
chooses a specific workflow command.

44.1 How to Configure Quick Action Bar Validation Rules
To configure validation rules to invoke in the Quick Action Bar:

1. Inthe Content Editor, edit the appropriate validation rules definition item as described in the
following sections.

2. Inthe Validation section, in the Quick Action Bar field, select validation rules.

4.4.2 How to Configure Validate Button Validation Rules

To configure validation rules to invoke when the user clicks the Validate command in the Proofing group
on the Review tab:

1. Inthe Content Editor, edit the appropriate validation rules definition item as described in the
following sections.

2. In the Validation section, in the Validate Button field, select validation rules.

4.4.3 How to Configure Validation Bar Validation Rules
To configure validation rules to invoke in the Validation Bar:

1. Inthe Content Editor, edit the appropriate validation rules definition item as described in the
following sections.

2. Inthe Validation section, in the Validation Bar field, select validation rules.

Note

The validation bar does not appear in Content Editor if the
/configuration/sitecore/settings/setting with name
ContentEditor.ShowValidatorBar has a value of false.

444 How to Configure Workflow Validation Rules
To configure validation rules to invoke when the user chooses a workflow command:

1. Inthe Content Editor, edit the appropriate validation rules definition item as described in the
following sections.

2. Inthe Validation section, in the Workflow field, select validation rules.

445 How to Create a Workflow Command or State Validation Action

To configure Sitecore to invoke the validation workflow action when the user chooses a workflow
command or when the user chooses a workflow command:

1. Inthe Content Editor, select the workflow state or command.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 31 of 59



Sitecore CMS 6.1 Client Configuration Cookbook @ S|teco re

2. Insert a validation workflow action definition item using the /System/Workflow/Validation
Action data template.

3. Inthe Data section, in the Type field, enter the following:

Sitecore.Workflows.Simple.ValidatorsAction, Sitecore.Kernel.

4. Inthe Max Result Allowed field, enter the maximum
Sitecore.Data.Validators.ValidatorResult value the workflow validation action can
generate. If validation generates a higher validation error level, the workflow validation action will
prevent the user from completing the workflow command. The default value for this field is
Warning.

5. Inthe Unkown Result field, enter a message to display to the user if the validator returns
Unknown as the validation result.

6. Inthe Warning Result field, enter a message to display to the user if the validator returns
Warning as the validation result.

7. Inthe Error Result field, enter a message to display to the user if the validator returns Error as
the validation result.

8. Inthe Critical Error Result field, enter a message to display to the user if the validator returns
CriticalError as the validation result.

9. Inthe Fatal Error Result field, enter a message to display to the user if the validator returns
FatalError as the validation result.

446 How to Configure Validation Rules for All Instances of a Data
Template Field Type

To configure validation rules to invoke for all instances of a specific data template field type:

1. Inthe Content Editor, select /Sitecore/System/Settings/Validation Rules/Field
Types.

2. Select the existing data template field type validation rules definition item, or insert a data
template field type validation rules definition item using the /System/Validation/Field
Type Validation Rules datatemplate. For the name of the field type validation definition
item, use the name of the field type as it appears in the Type field in the Data section of the field
type definition item.

3. Inthe data template field type validation rules definition item, in the Validation Rules section,
configure validation rules.

4.4.7 How to Configure Validation Rules for All ltems:

To configure validation rules for all items, in the Content Editor, select
/Sitecore/System/Settings/Validation Rules/Global Rules and configure validation rules.

4.4.8 How to Configure Validation Rules for an Individual Item or All
Items Based on a Specific Data Template

To configure validation rules for an individual item or all items based on a specific data template:

1. Inthe Content Editor or the Template Manager, select the individual item or the standard values
item for the data template.
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2. Show the standard fields as described in the section How to Show or Hide the Standard Fields.
3. Configure validation rules.
4. Hide the standard fields.

449 How to Configure Validation Rules for a Specific Data Template
Field

To configure validation rules for a specific data template field:
1. Inthe Template Manager, edit the data template field definition item.

2. Configure validation rules.

4.4.10 Default Item Validors

You can configure item validation rules using the following default validators.
Validator Function

Broken Links Identifies invalid references.

Duplicate Identifies items with a name or display name that matches the name

Name or display name of another item under the same parent (case-
insensitive).

Full Page Checks the validity of the output of requesting the item using the

XHtml default device.

Media Size Identifies media too large to serialize for database storage.

Too Big

Url Characters | Checks item names for characters requiring escape sequences in
URLs.

Note

XHTML validators validate the XML against the schema defined by the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
XHtmlSchemaFile.

4.4.11 Default Field Validators
You can configure field validation rules using the following default validators.

Validator Function

Broken Links Identifies invalid references.

Is Email Identifies invalid email addresses.

Is Integer Identifies invalid integers.

Is XHtml Checks validity of field against local XHTML schema.
Max Length Identifies field values containing more than 40 characters.
40
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Validator Function

Rating 1to 9 | Identifies invalid integers, negative numbers, and values greater than
nine.

Required Identifies empty fields.

Spellcheck Identifies fields containing spelling errors.

W3C XHtml Identifies invalidity against remote W3C validation service.

Validation

Alt Required Identifies missing Alt text in media library image data templates.

Extension Identifies media items with a dot character in the field named

May Not Start | extension, which is invalid.

with a Dot

External Link | ldentifies external links in Rich Text Editor fields that should open in a

Target new browser window and provide a title.

Image Has Identifies image fields that do not contain alternate text and that

Alt Text reference media items that do not contain alternate text.

Image Has Identifies image fields that do not specify alternate text and that

Alt Text from | reference media items that do contains alternate text.

Media Library

Image Size Identifies image field that references a media item that exceeds the
size limit.

Rich Text The width of images used in the Rich Text Editor must not exceed the

Image Size value of the /configuration/sitecore/settings/setting
element in web.config with name Media.MaxImageWidth.

Note

The value attribute of the /configuration/sitecore/settings/setting elementin

web.config With name HtmlEditor.ValidatorServiceUrl controls the URL Sitecore uses for

W3C XHtml Validation.
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4.5 Registering Validators

You can configure validation rules definition items to use the default validators, or register custom
validators.

Important

To maximize the performance of the Sitecore user interfaces, validators that consume significant
resources and especially processing time, such as to invoke external services or other potentially long-
running operations, should run in separate threads. Using a separate thread allows the system to invoke
additional validators before a validator completes. Sitecore will update the user interface as the different
validators complete.

45.1 How to Register a Validator
To register a field validator:

1. Inthe Content Editor, select the appropriate project-specific folder under
/Sitecore/System/Settings/Validation Rules/Field Rules or
/Sitecore/System/Settings/Validation Rules/Item Rules.

2. Insert a validator definition item using the /System/Validation/Validation Rule data
template.

In the Data section, in the Type field, enter the class signature.

4. In the Parameters field, enter URL-escaped key=value parameters, separated by ampersand
characters (“&”).

5. If the validator should run in a separate thread, in the Data section, in the Use Thread field, select
the checkbox.

45.2 How to Register a Regular Expression Field Validator
To register a regular expression field validator:
1. Reqgister the field validator.
2. Inthe Data section, in the Type field, enter the following:
Sitecore.Data.Validators.FieldValidators.RegexValidator,Sitecore.Kernel

3. Inthe Parameters field, enter the following:

Pattern=RegularExpression&Text=Message
4. Inthe Parameters field, replace RegularExpression with a regular expression.

5. Inthe Parameters field, replace Message with a message to display if the field does not match
the pattern. Sitecore will call String.Format () to substitute {0} in the message with the name
of the field.

45.3 How to Register an Integer Field Validator
To register an integer field validator:
1. Register the field validator.

2. Inthe Data section, in the Type field, enter the following:

Sitecore.Data.Validators.FieldValidators.IntegerFieldValidator, Sitecore.Kernel
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3. Inthe Parameters field, enter the following:

AllowNegative=AllowNegative=Boolean&AllowZero=Boolean

4. Inthe Parameters field, replace Boolean with True or False as appropriate.

45.4 How to Register an Integer Range Field Validator
To register an integer field range validator:
1. Reqgister the field validator.

2. Inthe Data section, in the Type field, enter the following:

Sitecore.Data.Validators.FieldValidators.IntegerRangeValidator,
Sitecore.Kernel

3. Inthe Parameters field, enter the following:

Min=Minumum&Max=Maximum
4. In the Parameters field, replace Minimum with the minimum allowed value for the field.

5. Inthe Parameters field, replace Maximum with maximum allowed value for the field.

455 How to Register a Maximum Length Field Validtor
To register a maximum field length validator:
1. Register the field validator.

2. Inthe Data section, in the Type field, enter the following:

Sitecore.Data.Validators.FieldvValidators.MaxLengthFieldvalidator,
Sitecore.Kernel

3. Inthe Parameters field, enter the following”

MaxLength=MaximumLength

4. In the Parameters field, replace MaximumLength with the maximum allowed length of the field
value.

45.6 How to Register Validators for Specific Iltems and Items Based on
Specific Templates
To register validation rules for specific items and items based on specific templates:

1. Inthe Content Editor, select /Sitecore/System/Settings/Validation Rules/Item
Rules.

2. Insert a validation rule definition item using the /System/Validation/Validation Rule
data template.

In the Data section, in the Type field, enter the class signature.

4. Inthe Parameters field, enter URL-escaped key=value parameters, separated by ampersand

“on

characters (“&”).

457 How to Disable Default Validation Rules

To disable default validation rules for all items:
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8.

In the Content Editor, select /Sitecore/System/Settings/Validation Rules/Global
Rules.

In the Validation Rules section, configure validation rules.

Select /Sitecore/System/Settings/Validation Rules/Field Types.

Configure validation in field type validation rules definition items.

Select /Sitecore/Templates/System/Media.

Show the standard fields as described in the section How to Show or Hide the Standard Fields.

For each of the data templates used for media, click on the data template definition item, then
click the Content tab in the editing pane, and in the Validation Rules section, configure validation.

Hide the standard fields.

Important

No character in an item name can match the regular expression specified by the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
InvalidItemNameChars. An item name must match the regular expression specified by the value
attribute of the /configuration/sitecore/settings/setting elementin web.config with name
ItemNameValidation. Do not change these two settings.

45.8

How to Override the Default Error Level for a Validator

To override the default error level for a validator:

1.
2.

In the Content Editor, edit the validator definition item.

In the Data section, in the Parameters field, add the following:

Result=Errorlevel

Replace ErrorLevel with the name of the error level in
Sitecore.Data.Validators.ValidatorResult.
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4.6 Custom Validators

This section describes procedures to implement a custom validator.

4.6.1 How to Implement a Custom Validator

A custom validator involves two components: a .NET class and a validator definition item.

4.6.2 How to Implement a Custom Validator
To implement a custom validator:

1. Create a class using the following prototype:

using System.Runtime.Serialization;
using Sitecore.Data.Validators;
namespace Namespace.Data.Validators.ItemValidators//TODO:namespace (Fieldvalidators)
{

[Serializable]

public class ClassName : Sitecore.Data.Validators.StandardvValidator

{

public ClassName () {}//TODO:class name

public ClassName (

SerializationInfo info, StreamingContext context) :base (info, context)
{
}

public override string Name
{
get
{
return (GetType () .ToString());//TODO:validator name
}
}

protected override ValidatorResult GetMaxValidatorResult ()
{

return (GetFailedResult (ValidatorResult.Error));//TODO:error level
}

protected override ValidatorResult Evaluate ()
{
if (false)//TODO:validate ControlValidationValue
{
return (ValidatorResult.Valid);
}

else
{
Text = "error message";//TODO:error message
return (GetFailedResult (ValidatorResult.Error));//TODO:error level
}
}

}
Replace Namespace.Data.ItemValidators with the appropriate namespace.
Replace all instances of C1assName with the class name.

Replace GetType () .ToString () with the friendly name of the validator.

a > DN

Replace all instances of with the appropriate validation error level.
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6. Replace false with logic to validate the field value in ControlvalidationValue or the item
returned by GetItem().

7. Replace error message with an error message.

8. Register the validator.

Important

If the result of GetMaxValidatorResult () IS FatalError Or CriticalError, Sitecore will block
operations such as save or workflow commands in the user interface as appropriate until validation
completes. To avoid blocking user interface actions during validation, the GetMaxValidtorResult ()
method of expensive validators should not return FatalError or CriticalError. Validation Bar and
Quick Action Bar validators never block user interface operations.
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4.7 Validation Actions

Validation actions represent clickable operations in the user interface to correct validation errors.

4.7.1 How to Create a Validation Action
To Create a Validation Action for a Single-Line Text data template field:

1. Create a class using the following prototype:

using Sitecore.Shell.Framework.Commands.ContentEditor.Validators;
namespace Namespace.Shell.Framework.Commands.ContentEditor.Validators//TODO:namespace
{
public class ClassName:ValidatorCommand//TODO:class name
{
public override void Execute (CommandContext context)
{
var validator=GetValidator (context) ;
if (validator!=null)

{

var control = GetControlToValidate (validator);
if (control!= null)
{
control = control as Sitecore.Web.UI.HtmlControls.Control;

if (control!=null)

{
control.Value=Value;//TODO:logic
Validate () ;

2. Replace Namespace.Shell.Framework.Commands.ContentEditor.Validators with the
namespace of the class.

3. Replace className with the name of the class.
4. Replace value with the validated value for the field.

5. Inthe Content Editor, select /Sitecore/System/Settings/Validation rules/Field
Rules.

6. Insert a validation action definition item using the /System/Menus/Menu Item data template.

7. Inthe Data section, in the Display Name field, enter the label the user should select in the user
interface to invoke the validation action.

8. Inthe /App Config/commands.config file, insert a new command based on the following
prototype:

<command name="validator:ClassName" type="Namespace.Class,Assembly"/>

9. Replace ClassName with the name of the class, and replace Namespace.Class, Assembly
with the namespace and the class signature.

Important

Because unsaved values are only available in the Ul and not in the database,
Sitecore.Data.Items.Item and other APIs are not available. The API used to validate fields
depends on the field type, and may involve JavaScript, such as for values of Rich Text Editor fields.
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4.7.2 How to Use a Validation Action
To Use a Validation Action:
1. Inthe Content Editor, edit an item that violates a validation rule that provides a validation action.

2. Inthe Validation Bar, right-click the validation indicator, and then select the validation action.
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The Page Editor

This chapter provides describes provides procedures to configure the Page Editor, which
provides CMS features such as inline editing and the Design pane.

This chapter contains the following sections:
e Page Editor Overview
e Placeholder Settings
e Page Editor Modes
e Edit Frames

e The Field Editor
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5.1 Page Editor Overview

As a user navigates the Web site, the Page Editor superimposes user interface elements that contain
editing functions on the items the user selects.

5.1.1 The Design Pane of the Page Editor

In the Page Editor, you can use the Design pane to configure layout details for content items. The Design
pane prevents users from binding presentation components other than those expressly allowed using
Placeholder Settings.

Note
The Design pane enforces component nesting order, prevents users from attempting to bind presentation
components to placeholders that do not exist, and inserts fully-qualified placeholder keys.
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5.2 Placeholder Settings

Placeholder settings control which presentation components users can bind to placeholders in the Design
pane in the Page Editor. For more information about the Design pane of the Page Editor, see the section
The Design Pane of the Page Editor.

Developers use placeholder settings:
e To help users choose appropriate presentation components to bind to placeholders.

e To prevent certain users from binding components to specific placeholders.

Layout details reference placeholders either by placeholder key, or by fully qualified placeholder key.® For
example, the fully qualified placeholder key for a placeholder with key content in a sublayout bound to a
placeholder with key main in a layout would be /main/content.

Note
The Design Pane of Page Editor uses fully qualified placeholder keys, but layout details do not require
fully qualified placeholder keys.

Placeholder settings definition items with names matching placeholder keys automatically apply to those
placeholders unless layout details specify placeholder settings. The placeholder settings definition item
named content automatically applies to all placeholders with the key content, including nested
placeholders, except where layout details specify placeholder settings. For the name of the default
placeholder settings definition item for a placeholder, use the placeholder key. For example, for the
placeholder with key content, edit the placeholder settings definition item named content.
Alternatively, by convention, use the fully qualified placeholder key, replacing slash characters (“/”) with
dash characters (“-”). For example, to control the placeholder with key content in a sublayout intended
bound to a placeholder with key main in a layout, insert a placeholder settings definition item named
content, or insert a placeholder settings definition item named main-content and associate this
placeholder settings definition item with the fully qualified placeholder key /main/content in layout
details.

Developers configure placeholder settings using placeholder setting definition items. Developers can
control the icon displayed for each placeholder by assigning an icon to each placeholder settings
definition item. Developers can restrict which users can bind presentation components to a placeholder
by denying write access to the placeholder settings definition item. Developers can enter HTML in the
Description field of the placeholder settings definition item to control the tooltip that appears when a user
moves the mouse over the placeholder in the Design pane in the Page Editor.

Important

Sitecore does not automatically apply placeholder settings using fully qualified placeholder keys to the
corresponding nested placeholders. For example, for the placeholder with fully qualified key
/main/content, if it exists, the placeholder settings definition item with name content applies, but the
placeholder settings definition item with name main-content does not. To cause different uses of
placeholders to apply different placeholder settings definition items, configure placeholder settings for
placeholder keys or fully qualified placeholder keys using layout details.

® For more information about layout details and placeholders, see the Presentation Component Reference
manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Reference.aspx.
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521

How to Create a Placeholder Settings Definition Item

To create a placeholder settings definition item:

1.
2.

5.2.2

In the Content Editor, select the /Sitecore/Layout/Placeholder Settings item.

In the Content Editor, with the /Sitecore/Layout/Placeholder Settings item selected,
insert a placeholder settings definition item using the System/Layout/Placeholder data
template. Name the placeholder settings definition item after the key of the placeholder that it
controls.

In the Content Editor, with the placeholder settings definition item selected, in the Data section, in
the Allowed Renderings field, select the presentation components users can bind to the
placeholder.

In the Content Editor, with the placeholder settings definition item selected, in the Data section, in
the Description field, enter a summary of the placeholder. Consider including a graphic indicating
the location of the placeholder within the layout or sublayout.

In the Content Editor, with the placeholder settings definition item selected, set the icon for the
placeholder settings definition item to control the image that appears next to the name of the
placeholder in the Design pane of the Page Editor. For instructions to set the icon for an item, see
the section How to Set the Icon for an Item.

To control which users can bind sublayout and renderings to the placeholder, configure write
access to the placeholder settings definition item.

How to Configure Placeholder Settings for a Data Template or an
Individual Iltem

To configure placeholder settings for a data template or an individual item:

1.

In the Template Manager or the Content Editor, select the standard values item or the individual
item.

In the Template Manager or the Content Editor, with the standard values item or the individual
item selected, click the Presentation tab.

In the Template Manager or the Content Editor, with the standard values item or the individual
item selected, on the Presentation tab, in the Layout group, click the Details command. The
Layout Details dialog appears.

In the Layout Details dialog, under the appropriate device, click the Edit button. The Device Editor
appears.

In the Device Editor, click the Placeholder Settings tab, and then click the Add button. The
Placeholder Settings dialog appears.

In the Placeholder Settings dialog, for Key, enter the placeholder key or fully qualified placeholder
key.

In the Placeholder Settings dialog, for Settings Item, click the Browse button, and then select the
placeholder settings definition item.
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5.3 Page Editor Modes

Each presentation component executes in a logical page mode depending on the user actions that
caused Sitecore to invoke the component.

The modes in which a presentation component may execute include:
e The published Web site.
e The browser-based debugger (with or without profiling and tracing active).
e Page Editor (with or without inline editing active).
e Preview.
e The Design pane of the Page Editor.

e WebEdit classic mode.

Presentation components can generate different output in different modes. For example, a presentation
component may populate the HTML <title> element with the value of a field. The browser cannot
provide inline editing facilities for the HTML <title> element. If the page does not use that field
elsewhere, then the user cannot edit the field in the Page Editor. In this case, a presentation component
used elsewhere on the page can output the value of the field elsewhere on the page if the user is inline
editing. As another example, consider a rendering that should not output a <div> element if a field value
is empty. To provide inline editing for the field, the rendering can output the <div> and the field editing
control if the field has a value or if the user is in inline editing in the Page Editor.

5.3.1 How to Determine the Page Editor Mode

You can determine the Page Editor mode using the sc:pageMode () XSL extension function or
properties of the Sitecore.Context.PageMode .NET object. For more information about the
sc:pageMode () XSL extension function and the Sitecore.Context.PageMode .NET object, see the
section Page Editor Modes.

For example, the following XSL code determines if the XSL rendering is running in any mode of the Page
Editor, as opposed to the published site:
<xsl:if test="sc:pageMode () /pageEditor">

<!-- the user is in the Page Editor. -->
</xsl:if>

The following C# code determines if the .NET component is running in the context of any mode of the
Page Editor, as opposed to the published site:

if (Sitecore.Context.PageMode.IsPageEditor)
{

// the user is in the page editor.

}

Note
The user can access multiple modes of the Page Editor simultaneously.

5.3.2 Page Editor Modes

The following table lists the XSL and .NET programming constructs to determine the page mode:
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sc:pageMode ()

.NET
Sitecore.Context.PageMode

@ Sitecore

Description of
Mode

/pageEditor

IsPageEditor

Accessing the Page
Editor.

/pageEditor/classic

IsPageEditorClassic

Using Sitecore 5
classic mode with
content markers.

/pageEditor/design

IsPageEditorDesigning

Using the Design
pane of the Page
Editor.

/pageEditor/edit

IsPageEditorEditing

Inline editing in the
Page Editor.

/pageEditor/navigate

IsPageEditorNavigating

Navigating in the
Page Editor but not

inline editing.
/preview IsPreview Previewing.
/normal IsNormal Published Web site
/profile IsProfiling Debugging and
profiling.
/debug IsDebugging Debugging
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54 Edit Frames

Edit frames provide insert borders with context menus around markup structures when the user edits
inline in the Page Editor. Edit frame commands activate Sitecore user interface commands.” An edit
frame generates a <div> element with an edit frame menu above it. Each edit frame command in the
menu activates a Sitecore command.
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The Buttons property of the edit frame control specifies an item in the Core databases that contains
children representing the edit frame menu items to expose in the edit frame menu. If you do not specify
an edit frame menu, Sitecore uses the default edit frame menu defined by the
/Sitecore/Content/Applications/WebEdit/Edit Frame Buttons/Default. This default edit
frame menu contains the Insert edit frame menu command that allows the user to insert an item using the
insert options defined for the data source of the edit frame.

/5 sitecore -- Webpage Dialog x|
) Insert
Select the item that you want to insert. You must give the item a name.

|[) Sample Item
() Folder

For an example of implementing an edit frame, including a custom edit frame command, see the section
How to Implement a Custom Field Editor.

" For an example that uses an edit frame to open the field editor, see
http://trac.sitecore.net/DefaultFieldEditor/.
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Note

You can configure the default edit frame menu by setting the value attribute of the
/configuration/sitecore/settings/setting elementin web.config with name
WebEdit.DefaultButtonPath.

Note
Sitecore does not support nested edit frames. An edit frame can contain any other controls, including the
FieldRenderer Web control that generates inline editing controls, but cannot contain other edit frames.®

541 How to Implement an Edit Frame Menu Command
To implement an edit frame menu command:

1. Create an edit frame menu command class that inherits from
Sitecore.Shell.Applications.WebEdit.Commands.WebEditCommand and implement
the Execute () method.

2. Add an edit frame menu command definition item to an edit frame menu. For more information,
see the section How to Define an Edit Frame Menu.

542 How to Define an Edit Frame Menu
To define an edit frame menu:

1. Inthe Sitecore Desktop, use the database icon in the task bar to select the Core database. For
instructions to select the Core database, see the section How to Select a Database in the
Sitecore Desktop.

2. Inthe Sitecore Desktop, with the Core database selected, open the Content Editor and select the
/Sitecore/Content/Applications/WebEdit/Edit Frame Buttons item.

3. Inthe Content Editor, with the /Sitecore/Content/Applications/WebEdit/Edit Frame
Buttons item selected, insert an edit frame menu definition item using the
/System/WebEdit/Edit Frame Button Folder datatemplate.

Tip
Alternatively, you can duplicate the /Sitecore/Content/Applications/WebEdit/Edit Frame
Buttons/Default edit frame menu definition.

4. Inthe Content Editor, beneath the new edit frame menu definition item, insert one or more edit
frame menu command definition items using the /System/WebEdit/Edit Frame Small
Button data template.

Tip
You can copy the /Sitecore/Content/Applications/WebEdit/Edit Frame
Buttons/Default/Insert item to your edit frame menu definition item.

Tip
You can duplicate an existing an existing edit frame menu command definition item and then update its
properties.

® For more information about the FieldRenderer Web control, see the Presentation Component Reference
manual at
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Reference.aspx.
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Tip
To insert the default field editor edit frame menu command, see the section How to Use the Default Field
Editor.
5. Inthe Content Editor, in each edit frame menu command definition item, in the Data section, set
the Header field to the menu label that should appear in the user interface
6. Inthe Content Editor, in each edit frame menu command definition item, in the Data section, set
the Icon field to an icon for the menu item.
Tip
You can also use this icon for the edit frame menu command definition item itself.°
7. Inthe Content Editor, in each edit frame menu command definition item, in the Data section, set
the Click field to the Ul command the menu command invokes.

8. Inthe Content Editor, in each edit frame menu command definition item, in the Data section, set
the Tooltip field to hover text for the menu item, and then save the edit frame menu command
definition item.

9. In the Sitecore Desktop, use the database icon in the task bar to select the Master database. For
instructions to select the Core database, see the section How to Select a Database in the
Sitecore Desktop.

5.4.3 How to Insert an Edit Frame in a Layout or Sublayout

To insert an edit frame into a layout or sublayout, add code such as the following:

<sc:editframe runat="server">
</sc:editframe>

You can set properties of the edit frame as described in the section Edit Frame Properties.

5.4.4 How to Insert an Edit Frame in an XSL Rendering

To insert an edit frame into an XSL rendering, add code such as the following:

<sc:editFrame>
</sc:editFrame>

You can set properties of the edit frame as described in the section Edit Frame Properties.

5.4.5 Edit Frame Properties

You can set the following properties of an edit frame:

Property (.NET) Attribute (XSL) Description

Buttons Buttons Edit frame menu items
define available
commands.

° For instructions to set the icon for an item, see
http://sdn.sitecore.net/reference/sitecore%206/client%20configuration%20cookbook.aspx.
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CssClass class Value for class attribute of
<div> element generated
by edit frame.

DataSource select The item to pass to edit

frame menu commands.

Debug debug Controls whether Sitecore
styles the <div> element
generated by the edit
frame.

FramePadding frame-padding Expand visible edit frame
around contents by number
of pixels indicated.

HintOffset hint-offset Pixels between edit frame
hovering menu and edit
frame region.

Style style Value for style attribute of
<div> element generated
by edit frame.

Title title Title of edit frame menu.

Tooltip Tooltip Tooltip for edit frame menu.

5.5 The Field Editor

The field editor provides an interface within the Page Editor that allows the user to edit fields for which the
Page Editor does not provide inline editing controls. The field editor user interface is highly streamlined in
comparison to the Content Editor.

a Sitecore - Sitecore Content Editor -- Webpage Dialog

E] pata 5 =1

@ x

Menu: Button width:

Menu: Dropdown width:

Don't wrap body text around image

r

[

OK | Cancel |

Developers often configure edit frame commands to activate the field editor. For more information about
edit frames, see section Edit Frames. Sitecore provides an edit frame command that you can use to
activate the field editor to edit the fields that you specify. You can activate the field editor from within the
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Page Editor to edit fields that do not provide inline editing controls, or to edit fields from more than one
item simultaneously.™

Warning
The field editor does not enforce item validation.

Important
You must activate the field editor programmatically.

55.1 How to Use the Default Field Editor

The default field editor includes the fields that you specify.
To use the default field editor:
1. Define a field editor menu as described in the section How to Define an Edit Frame Menu.
2. Inthe Content Editor, beneath the field editor menu definition item, insert the default field editor
command definition item using the System/WebEdit/Field Editor Button data template.

Note
This field editor command definition item invokes the webedit:fieldeditor command.

3. Inthe Content Editor, in the default field editor command definition item, in the Data section, in
the Header field, enter Edit Iltem.

4. Inthe Content Editor, in the default field editor command definition item, in the Data section, in
the Icon field, enter people/16x16/cubes _blue.png.

Tip
You can also use this icon for the edit frame menu command definition item itself. For instructions to set
the icon for an item, see the section How to Set the Icon for an Item.

5. Inthe Content Editor, in the default field editor command definition item, in the Data section, in
the Fields field, enter the names or IDs of the fields to include in the field editor, separated by a

pipe character (“|”).

Note
Field names are not case-sensitive.

Note
Sitecore does not generate an error if the field does not exist.

6. Inthe Sitecore Desktop, use the database icon in the task bar to select the Master database. For
instructions to select the Master database, see the section How to Select a Database in the
Sitecore Desktop.

5.5.2 How to Implement a Custom Field Editor

To implement a field editor that includes fields dynamically:

1% For an example that provides an edit frame menu command to open the field editor including all fields
in the item that are not defined in the standard template and do not support inline editing, see
http://trac.sitecore.net/DefaultFieldEditor/.
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1. Create a class that inherits from
Sitecore.Shell.Applications.WebEdit.Commands.FieldEditorCommand.

2. Inthe class, implement the GetOptions () method to create a list of fields to include in the field
editor.

3. Inthe GetOptions () method, pass the list of fields to the constructor for the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions class.

4. Inthe GetOptions () method, set additional properties of the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions object.

5. Inthe GetOptions () method, return the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions object.

6. Add the field editor command to the appropriate edit frame menu definition as described in the
section How to Define an Edit Frame Menu.

7. Configure an edit frame in a layout, sublayout, or XSL rendering to use the edit frame menu as
described in the section How to Insert an Edit Frame in a Layout or Sublayout or How to Insert an
Edit Frame in an XSL Rendering.

Note

The field editor merges all fields into a single visual section. You can set the Title and Icon properties
of the Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions objectto
control the icon label used for this section. Alternatively, set the PreserveSections property to true to
retain the original section structure.

Note

You can set the DialogTitle property of the
Sitecore.Shell.Applications.WebEdit.PageEditFieldEditorOptions objectto control the
title of the field editor browser window.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2009 Sitecore. All rights reserved.

Page 53 of 59



Sitecore CMS 6.1 Client Configuration Cookbook @ S|teco re

Security Based Configuration Features

This chapter describes the security features developers can use to optimize the user
experience of content authors, including the Sitecore security roles.

This chapter contains the following sections:
e Sitecore Client Security Roles
e Security Presets

e Data Template Field Security
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6.1 Sitecore Client Security Roles

Security administrators associate CMS users with one or more Sitecore client security roles to control the
features available through the Sitecore user interfaces.

Sitecore applications do not expose every feature to every user. Limiting available features provides a
number of benefits, including:

e Reducing the number of user interface elements improves performance and usability.

e Eliminating options prevents users from activating features inadvertently.

e Hiding unnecessary features minimizes training requirements.
A list of the specific features associated with each of the Sitecore roles is beyond the scope of this
document.

The following table summarizes the options provided by membership in each of the default Sitecore client
security roles:

Role Function

Sitecore Account Managing Access to user, role, and domain management
features.

Sitecore Client Authoring Access to content authoring features in the Content

Editor, the Page Editor, and the other applications for
content authors.

Sitecore Client Configuring Access to item configuration features in the Content
Editor.

Sitecore Client Designing Access to design features in the Content Editor and the
Page Editor

Sitecore Client Developing Access to the Developer Center and other
development features.

Sitecore Client Maintaining Access to data template management features.

Sitecore Client Publishing Access to site and item publishing features.

Sitecore Client Securing Access to the Security Editor and the other features
associated with assigning access rights.

Sitecore Client Translating Access to the content translation features.

Sitecore Client Users Allows users to log in to Sitecore clients. All of the

other Sitecore client roles are members of the Sitecore
Client Users role. Users in any Sitecore Client role are
automatically members of the Sitecore Client Users
role.

Security administrators use the following roles to restrict the features provided by membership of the
Sitecore Client Authoring role. Administrators can make less sophisticated users members of these roles
after assigning them the Sitecore Client Authoring role.

Role Function
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Role Function

Sitecore Limited Content Editor Limits features to provide a simplified Content
Editor interface.

Sitecore Limited Page Editor Limits features to provide a simplified Page Editor
interface.
Sitecore Minimal Page Editor Removes the ribbon from the Page Editor.

The following roles simplify security administration by providing default access rights to various branches
in the database, as well as including membership of the relevant Sitecore client roles:

Role Function

Author Provides access rights to the /sitecore/content branch of the
content tree. Member of Sitecore Client Authoring.

Designer Provides access rights to the areas of the content tree required when
making design changes. Member of Sitecore Client Designing.

Developer Provides access rights to the areas of the content tree required
during site development and maintenance. Member of Author,
Designer, Sitecore Client Developing, Sitecore Client Maintaining,
and Sitecore Client Configuring.

Sitecore also provides default roles to control access to features of the Online Marketing Suite (OMS):

Role Function

Analytics Content Profiling Provides access to maintain analytics profiles.
Analytics Maintaining Provides access to the Marketing Center.
Analytics Reporting Provides access to Sitecore Analytics reports.

If the default Sitecore roles do not meet your exact requirements for controlling the user interfaces, the
access rights in the Core database give more precise control over which features Sitecore exposes to
each user or role.

Important

To eliminate unnecessary features in the user interface and minimize the potential for users to invoke
features by mistake, users should be members of the fewest possible roles. The only exception to this
rule is the limited and minimal roles described previously; users should be members of these roles
whenever possible. Most users should only be members of the Sitecore Client Authoring role. When
users require additional functionality, security administrators can give them additional roles.

Important
Administrators have access to every feature, regardless of role membership. Minimize the number of
administrators.
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6.2 Security Presets
Security presets allow users to apply lists of access rights predefined by security administrators to items.
Security administrators use security presets:

e To simplify the process for end-users to apply access rights to content.

e To define common lists of access rights for users to apply to content.

e To provide single-click user interface components to apply lists of access rights that would

otherwise require multiple actions.

You can access the security presets in the Content Editor, in the Presets group on the Security tab, and
in the Security Editor, in the Presets group.

Tip
To minimize security administration, use security inheritance whenever possible.

6.2.1 How to Create a Security Preset

For the name of the security preset definition item, use a value appropriate for the command in the ribbon
that will invoke this security preset.

To create a security preset by defining access rights through the user interface:
1. Inthe Content Editor, select /Sitecore/System/Settings/Security/Presets.

2. Insert a security preset definition item using the /System/Security/Security Preset data
template.

3. Inthe Data section, in the Security Preset field, define access rights.
To create a security preset by copying access rights from an existing source item:

1. Inthe Template Manager or the Content Editor, select the source standard values item or the
individual item.

2. Show the standard fields as described in the section How to Show or Hide the Standard Fields.
Show raw values as described in the section How to Show or Hide Raw Values.

4. In the Security section, in the Security field, select the value, and then copy it to the Windows
clipboard.

5. Hide the standard fields.
6. Select /Sitecore/System/Settings/Security/Presets.

7. Insert a security preset definition item using the /System/Security/Security Preset data
template.

8. Inthe Security section, in the Security field, paste the value from the Windows clipboard.

Hide the standard fields and raw values.

6.2.2 How to Apply a Security Preset

By default, to apply security presets, a user must be an administrator, or a member of the Sitecore Client
Securing role.

Apply security presets using Content Editor or Security Editor.
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Tip
Use Security Editor when applying access rights to multiple items.
To apply a security preset using Content Editor:

1. Inthe Content Editor, edit the item.

2. Click the Security tab.

3. Inthe Presets group, click a security preset command. Sitecore copies the access rights defined
in the Security Preset field of the security preset definition item to the selected item.

To apply a security preset using the Security Editor:

1. Inthe Sitecore Desktop, in the lower left corner, click the Sitecore button, and then click Security
Editor. The Security Editor appears.

2. Inthe Security Editor, select the item.

3. Inthe Presets group, click the security preset command. Sitecore copies the access rights
defined in the Security Preset field in the security preset definition item to the selected item.
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6.3

Data Template Field Security

Data template field security separates the security rights that control access to an item from the security
rights that control access to the individual field values in that item.

Developers use field security:

To hide fields in the editing interfaces from some users.
To make fields in the editing interfaces read-only for some users.

To allow some accounts to update field values while preventing others from updating those fields.

For example, for search-engine optimization (SEO) purposes, an organization that uses the value of a
data template field to populate the HTML <title> element may not want all users with write access to
other fields to have write access to that field. Only certain users with write access to those items should
also have access to update the fields used for SEO. You can meet this requirement with field security.

By default, access rights in the item define access rights to all fields in the item. If a field defines access
rights, the user must have explicit field security access as well as access to the item containing the field.

How to Configure Data Template Field Security

To configure data template field security:

1.

2
3.
4

In the Template Manager, edit the data template field definition item.
Click the Security tab.
In the Security group, click the Assign command. The access rights dialog appears.

In the access rights dialog, grant and deny the field read and field write access rights for one or
more accounts.
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